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About M|Replay 

M|Replay is invaluable as a replay server for video production or as an adjudication system 
for referees. While recording, use on-screen controls, keyboard shortcuts, or hardware 
controllers to immediately playback an action that just happened. Select the camera you 
want to output and adjust the playback speed. M|Replay provides a playlist editor to 
assemble the highlights of your recording or any other imported footage for immediate 
playout. M|Replay is a software solution that runs on your Mac and with standard video 
devices from AJA, Blackmagic Design or Deltacast and it is the most flexible and affordable 
solution on the market. 

Simplicity  
Simply drag and drop the inputs and outputs to the viewer you want to assign it to, or select 
it from the drop-down menu. The user interface accommodates for many inputs and outputs 
that you can arrange the way you want. Use the on-screen controls, keyboard shortcuts or a 
jog shuttle to instantly go backwards on all the viewers simultaneously. Locate the important 
moment you want to replay, select the angle you want to show and play it back at the 
appropriate speed. You can even change the input while it is playing. All that is made to be 
quick and easy-to-use. 

Flexibility 
Enable the number of inputs and/or outputs you need and start working right away. 
As you can use the video device of your choice, you can adapt to every situation depending 
on the need of each production. Get the number of licenses that you need and connect the 
device that suits you best to your Mac. Create markers to instantly "jump" to an important 
moment and replay it using the angle you want. Create clips to build a playlist so you can 
chain different moments, from different angles and at the playback speed you want. You can 
even import video clips from the Finder to play in your playlist. 

Security 
M|Replay is based on a macOS architecture which is known for reliability and flexibility. All 
solutions developed by Softron Media Services are fully tested and approved before 
released. Prompt and personalized support is also what we do best. 

M|Replay 2.2 is a very intuitive program with a lot of features and functions. What follows is 
a brief explanation of how to use the application, beginning with installation instructions, 
followed by a description of the User Interface and then with instructions on how to get the 
most from the application. 
In addition to this user manual, you can also find a lot of information: 

• on our website: www.softron.tv; at the bottom of the M|Replay page you will find: 
- http://softron.tv/downloads: to download the latest version of OnTheAir Video.   
- Tech Specs: where you will find recommendations on what you need, what drivers 

to use, what video cards and codecs are compatible, etc. 
• in our Release notes.  
• on our support desk, there a lot of information is available in the help center. 
• on our YouTube channel, 
• and don’t forget to follow us on Twitter and Facebook for the latest Softron news 

 

http://www.softron.tv
https://softron.tv/products/instantreplay/mreplay
https://softron.tv/products/instantreplay/mreplay?content=downloads
https://softron.tv/products/instantreplay/mreplay?content=specs
http://softron.tv/news/Release-Notes/
https://softron.zendesk.com/hc/en-us
https://www.youtube.com/user/Softronmedia
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What’s new in M|Replay 2.2 ? 
With the release of M|Replay 2.2, important changes were made: 

• Full Compatibility with macOS Big Sur (11.0) and later. 
• Universal application for better performances on Apple M1 Silicon computers. Make 

sure to read the following article for more info on compatibility with M1 computers. 
• The maximum session duration is now 25h (was 9h). 
• Loop Recording to allow for continuous recording (ideal for time delay). Read more 

about this new feature here. 
• SKAARHOJ "Time Spin" (previously XC8): Added the ability to connect multiple 

"Time Spin" to one M|Replay. Simply configure multiple "Time Spin" to connect to the 
same IP address.Also added compatibility to "Blue Pill" models. Warning: Starting with 
version 2.3 of MIReplay, the SKAARHOJ devices needs to be in "server" mode in 
order to be supported. 

• Added support of bundled licenses (one serial can contain the license for multiple 
channels) 

• Added the ability to control playback rate using the REST API: GET /playbackrate?
rate=0 (0=stopped, 1= play forward, -1= play backwards, etc…). Also now logging the 
REST API calls in a separate file. 

• Updated AJA (v16.2), Blackmagic-Design (v12) and Deltacast (v6.19) SDKs. 
• When using UHD or 4K, session configuration now remembers if it's single link, quad 

link, etc... 

Warnings and Important Modifications 

• M|Family: Download the Deltacast drivers from our website. Download the universal 
version if you are on an Apple Silicon Mac, and the intel version if not. 

• SKAARHOJ "Time Spin" (XC8) Controler: As SKAARHOJ now ships the new "Blue 
Pill" model of the "Time Spin", we had to change the way M|Replay connects to the 
"Time Spin". If you own an older model of the "Time Spin", you should enable "Server 
Mode" in Device Core Options, and then set the IP address of your "Time Spin" in the 
Settings of M|Replay.  

 

http:///hc/en-us/articles/360017582199-Compatibility-with-the-Apple-Silicon-M1-chip
http:///hc/en-us/articles/4953414673426
http:///hc/en-us/articles/4953414673426
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❗ Known Issues:  

• No deinterlacing on Apple Silicon! There is an issue with the code that we used 
previously to deinterlace the outputs signal. We will change the code we use to support 
this, but until done, deinterlacing does not work on Apple Silicon, so if you use interlaced 
format, and do a pause, you will see either 2 frames simultaneously, or half of the image. 
Also, slow motion quality will not be as good as previous version. Note that the issue can 
not be seen in the preview, and there is no issue in the recorded files, the issue is there 
"only" in the output. The issue happens: 

> On Apple Silicon computers, with both the intel and universal versions. 
> On Intel computers, the issue is there only with the universal version. So if you are 
using interlaced formats, only an intel computer with the intel version of M|Replay will 
deinterlace. With the universal version, and on M1 computers with the intel version as 
well,  We will restore deinterlacing before the release, but if you are using an intel 
Mac, prefer to download the intel version. 

• Loop recording: This is work in progress, and when using loop recording, you won't be 
able to use the clips in the playlist. Only external clips. Resuming a session which has the 
loop recording option may not work as intended as well. 

• There is currently a bug in QuickTime X and Final Cut Pro with files longer than 12 
hours. They will play without audio. But the audio is recorded in the file, and if you export a 
shorter duration from M|Replay, you'll be able to access to it, but exporting or sending to 
Final Cut Pro X won't work for sessions longer than 12hours. 

• Creating the header for a 25hours file can take some time. The session will work 
immediately, but the send to Final Cut Pro X or reading the files directly won't work until 
the header is created. 

• High Frame Rate (HFR) capture is still in "alpha", and still work in progress, with support 
for max 2 channels currently, and there'll probably be more changes in the future. 

What’s to come in M|Replay 2.3 ? 

• Added the ability to create HFR inputs and outputs. Simply select multiple inputs/outputs, 
and select "Create HFR input/output". You can then use it as you would with any other 
input/output. 

• Added an "Export Status" window to show clips that are being exported, and their status. 

Warnings and Important Modifications 

• This version of M|Replay adds the support for High Frame Rate capture. It is still work in 
progress, so use this version with care. 

• Backup your previous sessions before opening them with this version. Indeed, when 
reopening a session, we will rewrite timestamps of the file, and it won't be possible to 
revert back. 

❗ Known Issues: 

•  High Frame Rate (HFR) capture support for max 2 channels currently, and there'll probably 
be more changes in the future. 

• Embedded timecode is mandatory (in sync in all inputs), even for non HFR capture. 
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Installing the Drivers for your Video Device 
If you use a video device from AJA, Blackmagic Design or our M|Family, make sure that the 
device is physically connected. Double check that all cables and hardware are installed 
correctly.  

Also check that you have the appropriate version of the driver and OS: 

1. On the Softron website, check which driver and OS is recommended for the card you use. 
2. Download the appropriate driver from the AJA, Blackmagic Design or Deltacast website. 
3. Make sure you use a compatible version of macOS 

Once the drivers are installed, verify the settings of your card using the Preference pane or 
control application (if applicable) included with the hardware. For example, with the M|8R, (or 
when using a Blackmagic-Design Quad 2 card), you may want to modify the “Connector 
Mapping” to make sure you can use all 8 connectors independently. 

In terms of licenses, you will need one license per channel. And each channel can be either 
in or out, so there is a lot of flexibility depending on the type of use that you want to have. 

Software Installation 
1. Download the M|Replay software from our website . 
2. Unzip the downloaded file. 
3. Drag and drop the M|Replay.app file in your Applications folder. 

First Start 
1. Start the application: Double click on the M|Replay icon in your Applications folder 

2. When prompted with the message “The “M|Replay.app” is an application downloaded 
from the Internet. Are you sure you want to open it?”, Click on Open. 

3. A license agreement window will open. Enter your First and last name and a valid email 
address. Tick the check-box and click on “Accept” 

4. Enter an admin password, to install the required components 

5. If you have a dongle connected to the computer with valid licenses for M|Replay, the 
application will start right away. 

6. If you do not have a dongle connected, a license window will open to offer you 3 
choices: 

• Register: if you own a serial number, click on this button and follow the procedure to 
activate it. You can read more about the activation procedures on our support desk. 

• Buy: if you don’t have a serial number, but want to buy one, click on that button. 
• Demo: if you want to try the application in DEMO mode, click here. In DEMO mode, M|

Replay can only create new Live sessions, it can not reopen an archived session. When 
a new Live session is created, there will be blue frames recorded in the files as well as 
blue frames outputted to the outputs. 

• Note that the license window will only open the first time you start the application. If you 
want to add a license, and upgrade or option later on, you can access the license 
window in the Menu “M|Replay > Licenses…”  

7. That’s it — you are ready to use M|Replay! 

 

https://softron.tv/products/instantreplay/mreplay?content=specs
https://www.aja.com/en/support
http://www.blackmagicdesign.com/support
https://softron-downloads.s3.us-east-1.amazonaws.com/apps/VideoMaster_Deltacast_macOS.zip
http://softron.tv/downloads.html
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1. Creating a New Live Session 

When you start M|Replay, a “Welcome window” is displayed.  

From this window you can either  

• “Create a new Live 
Session…” if you want to 
start recording and replaying 
a new session. 

• “Open Archived Session…” 
to reopen a session that has 
already been recorded. 

You can also see the list of 
sessions recently created or 
opened on the right, with their 
creation date, and size. If you right-click on any of these you can select to “Show in Finder” 
to be able to see where those sessions are saved and eventually delete them if you don’t 
need them anymore. 

When you click on “Create a new Live Session…”, this window will open: 

• Name: for your Live Session 
• Record to: Select your folder 

(make sure to have enough 
disk space available) 

• Pre-allocate SAN storage if 
possible: Some SAN Volumes 
allow for pre-allocation (such 
as Xsan). If possible we will 
try to preallocate the storage, 
so only one write request is 
done to the SAN. Note that 
this won't actually write or 
use the storage, it is "just" 
doing just one request at start, instead of a request overtime we need to write to the disk. 

• Video Mode: This will set the format of all the inputs and outputs. With some video cards, 
additional options will show up, such as if you want to use quad link or single link for 4K. 

• Preset duration: When you enable an input, we will start recording right away and create a 
“Classic” movie file (as in MovieRecorder) of the duration you specify here. Note that if your 
recording session is longer than that, we will extend the duration up to 25 hours which is the 
maximum duration of a recording session (because of a limit to the duration of QuickTime 
movies). When your session reaches 25 hours, recording will stop. 

• Loop: Sets if you want to record your session in Loop. When Loop mode is enabled, you can 
replay 24/7 with a single session. Once the Preset duration is reached, M|Replay will start 
writing again at the beginning of the file, erasing the first frames recorded up until you stop the 
recording session. Note that if you had created clips, they will be deleted once we start erasing 
the first frames. You can export the clips before that to keep a track. 

• Remaining Space: Already shows you how much disk space you have left on the selected 
destination. 
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2. Enabling Inputs and Outputs 
In the left pane you will see all the Inputs and Outputs that are available on your Mac:  

Depending on which video device you use, you will be able to see more or less of them. 
Note that for some devices (such as with the Decklink Quad 2), if you enable for example the 
Input 1, you won’t be able to enable the corresponding Output 1 as these Inputs or Outputs 
share the same connector. 

If you use the M|8R or a Decklink Quad 2 or Duo 2, make sure to read the article of our 
knowledge base that explains the things to know about the “Connector Mapping” 

 

You can also enable the outputs that you need for the production simply by enabling the 
checkbox or drag-and-dropping the output on any of the Viewers. 

Note that you can also create “Virtual Outputs” simply by clicking on the “+” icon at the 
bottom of the list. Delete them using the - icon. Note that “Virtual Outputs” are used rather 
for testing purposes, or for example to preview a playlist on screen, without using a “Real 
video output”. 

 

As soon as you enable an Input (by ticking the checkbox in front of it), the 
recording starts, there is no Start Record Button. If you want to stop recording on 
that specific input, just disable it. To enable an Input, you can also simply drag and 
drop it on any of the Viewers in the central Viewers area.

https://softron.zendesk.com/knowledge/articles/114093989034/en-us?brand_id=1102326
https://softron.zendesk.com/knowledge/articles/114093989034/en-us?brand_id=1102326
https://softron.zendesk.com/knowledge/articles/114093989034/en-us?brand_id=1102326
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3. The Viewers Area 

The Viewers area is the main area. The Viewers panel displays a number of important 
elements of M|Replay:  

• The Current Time,  

• The Delay,  

• The In and Out Point Controls,  

• The Playback Rate,  

• The Viewers 

• The Playback Controls,  

..As well as a few other UI Controls.  

Each of these elements is described below.  This screenshot shows the Current Time, the 
Delay, and the In and Out Point Controls: 

• Current Time: This is the actual current time. 

• Delay: This shows the number of hours, minutes, seconds, and frames behind the Current 
Time, and is displayed when the clip has been rewound.  Note that while the clip is 
Delayed, it is still recording Live.  If the clip is playing Live in the Viewers, this display will 
show ”Live,” rather than as a Timecode display. 

 

• The In and Out Point Controls: Flanking the Delay display are two round buttons, the one 
on the left labeled “In” and the one on the right labeled “Out.”  Clicking the In button will 
begin recording multiple clips — one per Input — and clicking on Out will stop the 
recording.  While the clips are being recorded, the In button will be a solid white color, 
rather than an empty circle.  Once the recording is stopped, the clip will appear in the 
Browser panel to the right of the Viewers.  You may also use keyboard shortcuts to start 
and stop recording a clip: “I” to set the In Point, and “O” to set the Out Point. 

• The Playback Rate:  This is the rate in which the Viewers are displaying the playback of 
the video inputs.  The Playback Rate is set using the Playback Controls at the bottom of 
the Viewers panel. 
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3.1. Assigning Inputs or Outputs to Viewers 

Each Viewer may be set up to view an Input 
or an Output.  When M|Replay is first 
opened, each Viewer will be dark, with the 
Softron logo and a prompt in the upper left-
hand corner asking you to “Select a 
Source…”   

You may click on the prompt and select the 
Input or Output source from the selection 
offered, or you may simply drag and drop an 
Input or Output source from the appropriate 
panel to the left.  

3.2. Selecting an Input for an Output 

If a source is assigned to a Viewer, you will also see a popup menu at the top right that 
allows you to select the input that is “sent” to that output. You can simply change the 
assigned input by selecting if from the list. 

You can also change that using keyboard shortcuts: 

• First make sure that the “Viewers” are is the active one (it has a blue bar above) 
• Then make sure that the output you want to control is selected (it will be circled in 

blue). For that you need to either: 
> Click on it 
> Use the keyboard shortcuts “1, 2, 3…" to select the first Viewer, the second, 
etc… 

• Then once the viewer is selected, either: 
> Use “option + click” on the viewer of an input to “assign it” to the selected 
output 
> Use the keyboard shortcuts “alt + 1, 2, 3…” to assign the input in the first  
Viewer, the second, etc… to the selected Output. 

Once your sources have been selected, the Viewers will display the Input or Output at 
whatever Playback Rate you select, and the Source name will be displayed at the top of the 
Viewer.  Also present on each viewer is a speaker icon, where you may turn the volume on 
or off. 
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3.3. Playback controls in the Viewers Area 
You can control the playback in the Viewers area in one of these manners: 

• At the bottom of the user interface are some playback controls to play forward, 
backward, or at variable speed.  

• Use the keyboard shortcuts. For example the standard JKL, space bar, left, right arrows 
and “P” to go back in “Live”. (See a more complete list in chapter Keyboard Shortcuts) 

• Use a hardware controller (SKAARHOJ "Time Spin", Contour SHUTTLEPro, or Elgato 
Stream Deck) 

Note that when you use those playback controls, all the Inputs will be controlled in sync, so 
you can see what happens on all angles at a specific moment. 

3.4. Swapping Viewers 

You may simply click on a viewer and drag it over another viewer, release the mouse, and 
the two viewers will change position. 
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4. Clips and Markers 

The Browser panel shows the Clips you have created by 
using the Input and Output Controls.  It also shows any 
Markers you have created (by hitting “M”, or by clicking on 
the “+” button at the bottom left of the panel).   

• Name: the name of the Clip or Marker, which can be 
modified by highlighting and then clicking on the name, 
and then typing in the new name. 

• Start: the start time of the clip. 

• End: the end time of the clip  

• Duration: the Duration of the Clip in Hours: Minutes: 
Seconds: Frames.   

Note that Markers do not show an End time or Duration. The Marker presents only the time 
that it was created.  Clips are identified with a film strip icon to the left of the name, while 
Markers are identified with blue pointer icons. 

 

4.1. Pop-Up Menus 

• “Right-clicking” on a Clip opens a pop-up menu that 
allow you to: 

> Export (to the destination presented in the 
Settings tab of the Menu) 

> Export To… (a destination chosen when you 
select this item) 

> Cancel Export 

> Show in Finder (shows the location of the 
exported files in Finder) 

> Go to In (takes the Viewers to the In Point of 
the Clip)  

> Go to Out (takes the Viewers to the Out Point of the Clip) 

> Delete (deletes the Clip) 

• “Right-clicking” on a Marker opens a pop-up 
menu that allows you to: 

> Go to In (takes the viewers to the In Point 
of the Marker) 

> Duplicate (the Marker you selected) 

> Delete (deletes the Marker) 
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• “Double-clicking” on a Clip takes the Viewers to the In Point of the Clip, and the Viewers 
will play until it reaches the Out Point, at which time the Viewers will Pause. 

• “Double-clicking” on a Marker takes the Viewers to the In Point of the Markers, and the 
Viewers will play from that point. 

You may delete any Clip or Marker by selecting it and then clicking on the “-“ button at the 
bottom left of the panel (or by right-clicking on it and selecting Delete on the pop-up menu). 

4.2. Creating Clips and Markers 

To create Clips and Markers, make sure that the “Viewers” area is active, then go to the 
position you want and use the following keyboard shortcuts: 

• “I” to create an In Point 
• “O” to create an Out Point 
• “M" to create a Marker 

Note that when you have set an In Point the ‘In’ icon will be shown:  
• If you use try to set an In point again, the In Point value will be modified. 
• Then if you set an Out Point, the clips will be immediately created. 

You can also use the following keyboard shortcuts: 
• “option + I” (or “O”) to clear the in or out point. 
• “option + x” to clear both in or out points. 
• “shift + I” (or “O”) to go to the in or out point. 

4.3. Modifying Clips and Markers 
To modify a clip and marker, you can : 

• Click on its name to modify its Name 
• Click on its In or Out Points to modify manually their value 

4.4. Using Clips and Markers 
From the Clips and markers are, you can: 

• Double-click on a clip to start playing it back from its In Point. If you hit play it will play 
until its Out Point. 

• Double-click on a Marker to start playing from that point. 
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5. Create a Playlist 

You can drag and drop clips to the Playlist area. You can use clips from the clips and markers 
area above, or other clips from your storage. 

When a clip is in the playlist area, you can 
select the “angle” that you want to play out 
as well as the playback speed. 

To play the playlist, you need to make sure 
that an output is selected for that playlist: 

5.1. The Playlist Window  
 

There is two Timecodes: 

> The one on the left shows the time 
played on the currently playing Clip. 

> The one on the right shows the time 
remaining for the entire Playlist. 

The Select Output button: Clicking on it 
allows you to select the Output on which you 
would like to play out the Playlist.  

The Standard Playback Controls: (Play 
Previous Clip, Pause, Play, and Play Next 
Clip), and then buttons to Chain the clips 
(play each clip in sequence) and to Loop the 
clips (replay the selected clip over and over, 
or to replay the entire Playlist if both the 
Chain and Loop buttons are active). 

The Playback Controls: the clips you have 
dragged from the Browser. Each Clip has a 
thumbnail to the left, the Playback Rate 
below the name (adjustable by highlighting 
the clip and then clicking on it, which opens a 
window with a sliding bar and numeric 
indicator, both of which can used to adjust 
the Playback Rate).   

The Clip Duration is displayed, below which is shown the selected camera-angle (which 
may be changed by clicking on and then selecting the Input you would like to use). 

Right-clicking on a Clip opens a window that allows you to Export Playlist (to the default 
destination determined in the Settings menu), Export Playlist To… (a destination chosen 
when you select this item), or to Cancel Export. 

In that Playlist Panel, two buttons: a “-“ and a Gear.  The “-“ button allows you to delete a 
clip (by selecting the clip and then clicking the “-“ button).  Clicking the Gear button opens 
the same Export window accessed by right clicking on a clip.  
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6. Exporting Clips and Playlists 

You can export clips and playlists so they can be reused later on. 

6.1. Changing the Export Settings 

As we want things to go quick during a live session and don’t want to have menu asking for 
settings, the Export Settings are done in the Settings of the application. 

You can set: 
• Export Directory: set where the clips will be exported. 
• If File Already Exists: when two clips have the same name, decide if you want to Keep 

Both clips, Replace the old clip, Skip the export or Stop the export.  
• Add Handles: set the number of seconds you want to add before and after your In/Out 

point to the exported clip. 

6.2. Exporting Clips 
From the “Browser” area, select the clips you want to export. Then right click on it and 
select “Export” from the drop down menu. The export will start right away. Note that all 
angles of the clip will be exported.  
You can cancel the export of one or more clips by selecting the clips for which you want to 
cancel the export, right click on it and choose “Cancel Export”. 

6.3. Exporting Playlists 
Note that currently only clips from the recorded angles will be exported. External clips will 
be skipped during export. The method to export playlists is the same as the one for clips. 
Note that the if you modify the playlist after you have started an export, it won’t reflect in the 
exported file, you will have to export again the playlist. 
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7. Contour ShuttlePRO v2 
With M|Replay you can control the software using mouse and keyboard, but it is much more 
efficient to use a dedicated hardware controller. We support three controllers: 
• SKAARHOJ's "Time Spin" (Previously known as XC8) is the most versatile one. It has 

buttons to create markers, set in/out points, and to select the angle to be used; and a 
jog shuttle wheel and a T-bar to control the playback speed. 

• Contour Design's ShuttlePro has buttons to create markers and set in/out points, and 
a jog shuttle wheel to control the playback speed. 

• Elgato's Stream Deck has only buttons to create markers or to control the playback. It 
is very limited for playback control, so the best usage of this product is to create 
markers, which can be customized and the buttons can be labeled. 

7.1. Viewers Area 
Certain functions of the controller depend on the user's current workspace in M|Replay. 
There are three areas - the views, the clips and markers, and the playlist. Below are the 
triggers that are active application-wide. 
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7.2. Clips and Markers Area 
 

 



-  -19

M|Replay User Manual

7.3. Playlists Area 
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8. Setting Up SKAARHOJ’s "Time Spin" 
M|Replay supports also SKAARHOJ's "Time 
Spin". It is the most versatile one. It has 
buttons to create markers, set in/out points, 
select the angle to be used, a jog shuttle 
wheel and a T-bar to control the playback 
speed. 

 

 

8.1. Requirements for the Setup 
To setup your "Time Spin": 

• First you will need to connect your "Time Spin" in USB to your Mac (you'll only have 
to do this once). 

• Then download the firmware updater application from SKAARHOJ: https://
www.skaarhoj.com/support/firmware-updater/ 

• Install the application and 
start it.  

• Make sure that you do see 
something like this in the 
"Port" popup menu: 

• If the menu is empty, 
check your USB 
connection to the "Time 
Spin".  

If you see something like /dev/
tty.usbmodem143220 in the 
popup menu, you are ready to set 
it up. 

Note that: 
• the USB connection is only needed for the setup part, not to control the "Time Spin" 

after it has been setup. Control later on is done through ethernet. 
• the USB connection is mandatory for the setup part, you can not do the setup 

through ethernet. 

 

There are compatibility issues with some network ports. The 10Gb port of the iMac 
Pro and Mac mini are currently not compatible with the "Time Spin". So you will 
need to use a USB to Ethernet adapter to use a "Time Spin" on these computers.



-  -21

M|Replay User Manual

8.2. Setting Up the "Time Spin" as a "Raw Panel"  

Note that your "Time Spin" may come already configured as a "Raw Panel", and in this case 
you can skip this step, you won't need an internet connection, and you just can setup the IP 
address if needed (see below). But if your "Time Spin" is not configured as a Raw Panel (for 
example it was used with another software or hardware), you will need an internet 
connection the first time you want to setup your "Time Spin" following these steps. 

• (first follow the steps above for the App). Once the Firmware Updater app is 
downloaded and installed, start it and click on the "Online Configuration" button: 

• This should open a web page on SKAARHOJ's website where you can make sure 
that it's the ""Time Spin"-Raw Panel" configuration that is Active, if not, click on the 
radio button, so it shows as Active:  

• Note that the screenshots here are with the "simple" configuration. Note that there is 
an "Advanced" button on the page that can show you more settings. You can work 
with the Advanced view too, just make sure to configure the panel as a "Raw-Panel"... 

• You can see that there are other network settings at the bottom, you don't need to 
set them up , but you can. See next step about modifying the network configuration. 
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• Now that you have saved that configuration, you can go back to SKAARHOK App, 
and click on the "Check for updates" button, and you should see that a new firmware 
is created (based on the settings that you have just done): 

• Then you should see different phases, (updating, verifying, etc...) and when it says 
that the Firmware was updated, your "Time Spin" has rebooted, and you should be 
good to go. 

• Now you can start M|Replay, create a new session and the button will light up (note 
that the buttons will only light up once a session is created or opened). 

8.3. Modify the Network Configuration and Devices 

Now that you have made sure your panel is setup as a "Raw panel", and in order to be able 
to control the "Time Spin", you need to configure 2 things: 

• its network configuration (the "Time Spin" own IP address and subnet) 

• its "devices": the IP address of the computer where M|Replay is running and that it 
should control. This should be modified every time you want to use a different 
computer with M|Replay. 

With the "Time Spin", you can either configure them with the "Online Configuration or the 
"Local Configuration". The local configuration is easier to deal with as it does not require an 
internet connection. 
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8.3.1. Online Configuration (Internet Connection Required) 

The workflow is happening at the same place as the one done for the "Raw" panel 
configuration. 

• Start the SKAARHOJ Firmware Updater application and click on the "Online 
Configuration" button 

• This should open a web page on SKAARHOJ's website. At the bottom of the window 
set the Network configuration. The first part is the IP configuration of your "Time 
Spin". Setup the IP address you want to assign to your "Time Spin": 

• And the last part, in the "Devices" area, setup the IP address of the computer that will 
control the "Time Spin" (note that these IP configurations can be modified directly 
from SKARHOOJ's application on your Mac, you won't always need an internet 
connection just to change the IP address): 

• Now save on the "SaveNetwork Configuration" button at the bottom of the page: 

  

 

https://www.skaarhoj.com/support/firmware-updater/
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8.3.2. Local Configuration (Internet Connection not Required) 

• Start the SKAARHOJ Firmware Updater application and click on the "IP Config" menu 
at the top of the window:  

• In the window that opens, you will be able to set first the IP settings of the "Time 
Spin" itself. Enter an IP address that is within your IP range, or enable the DHCP 
setting: 

• Then in the second part of the window, even more important, set the IP address of 
the computer that will control the "Time Spin", and make sure that the "Enabled" 
checkbox is indeed enabled:  

• Then click on "Save Settings" 
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8.3.3. Understand the Configuration and IP Recommendations 

As you can understand from the last part of the setup, it is the "Time Spin" controller that will 
in fact connect to your computer, and not the other way around. You don't need to set any IP 
address of the "Time Spin" on your computer itself or the M|Replay preferences. It's the 
"Time Spin" who know who it will talk to. 

The downside of this is that it means you will need to connect to your "Time Spin" with USB 
every time you want to use a different computer with M|Replay or every time your IP address 
changes. This is why if you can enable DHCP for the "Time Spin" itself, it is recommended to 
use a fixed IP address for your computer and not DHCP. Otherwise, you may loose 
connection to your "Time Spin" when restarting your computer (as your DHCP server may 
attribute you with a different IP address). 

  

8.4. Cores vs Raw Panel 

If you are familiar with SKAARHOJ, you may know that they are using the concept of "Cores", 
which are basically the ability to control other devices. SKAARHOJ's controllers can be used 
in many ways, and one device can sometimes control multiple pieces of equipment. All this 
needs to be configured. The idea that they had is that you configure your device on their 
website, add "Cores" (such as a Core to control an ATEM, one to control a Camera), then 
setup what each button will do on your SKAARHOJ's device. Then once you have 
configured it, you save a firmware that is then loaded on your device. 

This is very nice in terms of flexibility, but at Softron we try to do things that are "plug and 
play". So this is why we have not implemented Cores, and have done all the work for you. ;-) 
Once the panel is configured as a Raw panel, we will just control it, there is nothing that you 
need to setup. But don't search for Softron's core then... 

  

8.5. Troubleshooting 

If after you have followed the steps above, you still can not control it, check the following: 

• double-check that it is configured as a "Raw Panel" 

• make sure of your network connections. Check the IP of your computer, then check 
what you have set in the "Unisketch Raw Panel" preference in SKAARHOJ App > IP 
Configuration. The 2 must match. If they match, make sure that you can "ping" the 
"Time Spin" from your computer, there might be a network issue. Don't forget that M|
Replay connects to the "Time Spin" with Ethernet, not with USB. 

• a reminder that currently the 10Gb ethernet port of the iMac Pro and Mac mini is not 
compatible with the "Time Spin". So you will need to us an adapter. 
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9. Using SKAARHOJ’s "Time Spin" 
Once the "Time Spin" is setup and configured, when you start M|Replay, you should see 
some buttons lighting up, as well as the screen. It is important to know that, as with the other 
controllers, depending on which area of M|Replay is active (the sources, viewer, browser or 
playlist), buttons and controls may have different "roles". Also, different buttons may light up 
or not (if some buttons don’t show up immediately, don’t hesitate to push again on them). 

9.1. Overview 

There are 6 main areas on your "Time Spin" that we’ll refer to in this manual: 

• Top buttons: Select which output is selected in the Viewers area and which input is 
assigned to it. 

• T-bar: Control the playback speed 
• Vertical NKK buttons: Perform different actions such as go to live, select the active area, 

or the shift key 
• Display: Shows the selected output and each assigned input. 
• Horizontal NKK Buttons: Set in/out points, mark, play/pause 
• Jog/Shuttle: Depending on the active area, it will either control the playback, or allow to 

select a clip in the browser or playlist. 

More information just below…  
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9.2. Top Buttons 
 
This is where you will be able to set: 
• The selected output 
• Which input is assigned to it 
• The behaviour of these buttons do not 

change depending on the active area, 
they always control the selected outputs 
and inputs of the Viewers area. 

Note that the number of the input or output is depending on the order in which they show 
up in the Inputs and Outputs panes.  

9.2.1. Set the Active Output 

The active output is the one that is highlighted in blue. In the screenshot below, it’s the top 
left viewer: 

You can also see which output is active in the Display, it’s the one highlighted. In the 
screenshot below, it’s "Output 2": 

To change the active output with the "Time Spin", hold the SHIFT button down (at the bottom 
of the vertical NKK buttons), the buttons at the top will be white to show the numbers of 
output available and the active one will be blue. Just push on the output number you want to 
select. 
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9.2.2. Set the Assigned Input 

You can view which input is assigned to an output in the user interface of M|Replay (if the 
overlay option is set to always display the input/output overlays). In the screenshot below, 
input 1 is assigned to output 1: 

You can also view this in the "Time Spin" display. In the screenshot below, Input 3 is 
assigned to Output 1: 

And finally one of the top buttons will be red to show the assigned input of the active output. 
To change which input is assigned to the active output, simply push on the number of the 
input that you want to assign it to.  
To assign the playlist, push on the bottom left button, one without number. In the screenshot 
below, it’s the playlist that is assigned to the active output: 
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9.3. T-Bar 
The T-bar controls the playback speed of the active output in the Viewers. As with the top 
buttons, the behaviour does not change depending on the active area of the M|Replay user 
interface, it will always (and only) control the playback of the active source in the Viewers.  
When the T-bar is at the bottom, playback speed is set to zero (stop), and when it’s at the 
top, playback speed is 1 x (play). 
Note that it currently only works if it’s an input that is assigned, not if it’s a playlist. 

9.4. Vertical NKK Buttons 
There are different actions that can be done with these buttons.  

• The most important one is the "LIVE" button at the top. It allows you to go 
back to Live for the active output. The button will be red when you are 
Live. 

• Then the SHIFT button at the bottom is a button that you can use to use 
the secondary functions of the buttons (the one showing up in Blue on 
the buttons). Hold the SHIFT button down to use the secondary functions. 

• The remaining 3 buttons. Without the SHIFT button pushed allow you to 
select the active area: 

> VIEWR: select the Viewer as the active area 
> BROW.: select the Browser as the active area 
> PLST: select the Playlist as the active area 

• Note that depending on which area is active, one or the other of these 
buttons will be lit.  

• With the SHIFT button pushed: 
> LIVE IN: not available currently 
> APPEND: Add the selected clip in the browser at the end of the 
playlist 
> INSERT: Add the selected clip in the browser above the selected 
clip in the playlist. If no clip is selected, it will at at the end. 
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9.5. Display 
The display shows a few information. It shows the list of outputs, which one is active (the 
one highlighted) and which inputs are assigned to it. When either an in or out point is 
selected, it shows the set timecode 

9.5.1.  Horizontal NKK Buttons 

• The most important one here is the play/pause button. Depending on the active area, this 
button will either control the playback of the active output in the viewer (If the viewers area 
is active), or the playlist (if the playlist area is active). 

• The other four buttons, without the SHIFT button pushed: 
> IN: Set an in point at the current playback position in the Viewers area (even if the 
Viewer area is not active) 
> OUT: Set an out point at the current playback position in the Viewers area (even if 
the Viewer area is not active) 
> MARK: Add a marker at the current playback position in the Viewers area (even if 
the Viewer area is not active) 
> NEXT: Skip to the next clip in the playlist (even if the Playlist area is not active) 

• With the SHIFT button pushed: 
> GO TO IN:  

- If the Viewers are is active and an in point is set, goes to the in point. 
- If the Browser area is active and a clip is selected, goes to the in point of the 
selected clip. 

> GO TO OUT:   
- If the Viewers are is active and an out point is set, goes to the out point. 
- If the Browser area is active and a clip is selected, goes to the out point of 
the selected clip. 

> GO TO TC: Allow you to type (on your keyboard) a timecode so the playback 
position goes to that TC (even if the Viewer area is not active). 
> NEXT: Skip to the next clip in the playlist (even if the Playlist area is not active) 

9.6. Jog/Shuttle Wheel 
The jog shuttle wheel allow for different actions, depending on the active area: 
• If the "Viewers" area is active, the jog and shuttle control the playback of the active output 
• If the "Browser" area is active, only the jog allows you to select a clip in the list 
• If the "Playlist" area is active, only the jog allows you to select a clip in the playlist 
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10. Elgato Stream Deck 

M|Replay can be controlled simply using a Stream Deck from Elgato. Two options exist :  
• Use the integration that we have built in our software, 
• Or use the software that Elgato is providing, 

It will be one or the other.  

10.1.1. Softron Integration 

First, start your Softron application. Depending on the application that you use, you will have 
different layouts.  
If you go to the menu "Window > Show Stream Deck window", you should see a window 
such as this one: 

There are two sections in the window: 
• To the left is the list of available pages, with their names and which kind of Stream 

Deck device they are for. 
• To the right is the list of Stream Deck devices that are connected to your computer. On 

the screenshot above, there is a "Classic" and a “Mini” 

As we wanted to allow you to select which device you want to use for each application. 
Before you can start using your Stream Deck, you have to drag and drop at least one page 
from the list on the left on to one of the device on the right.  
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You can also decide to enable the "Hold" option. This option is important for two things: 
• if you want to be able to trigger your Softron application, even when using a different 

application 
• if you are using multiple Stream Decks and you want each to use a different 

application 

10.1.2. Customizing the Pages 

You can create new pages by clicking on the “+” icon at the 
bottom of the pages list: 
Each page can also be modified. For this, right-click on any of 
the page, and select "Edit": 
Or you can click on the triangle. 

When you are editing a page, you will see the device in big, with the list of possible actions 
on the right: 

  
You can drag and drop actions from one button to another to move them, or from the list to a 
button. Click on "OK" when you are done.  
 

 

In order to be able to use the Softron integration, you need to make sure that the 
"Stream Deck" software is not running. If it is running, it will prevent us to access 
the Stream Deck. So make sure that it is not set to automatically launch at startup. 
If you need help, check our webpage explaining how to use a the Stream Deck 
Controller

https://softron.zendesk.com/hc/en-us/articles/360015242494-HOW-TO-Use-Elgato-s-Stream-Deck
https://softron.zendesk.com/hc/en-us/articles/360015242494-HOW-TO-Use-Elgato-s-Stream-Deck
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10.1.3. Customizing the List of Actions 
	 	  
In the edit window, you can create a new action by clicking on the + icon at the bottom of 
the list. You can also select an action, right click and select either "New" or "Duplicate" (note 
that you can not edit the default actions). 

After a new action is created (or duplicated), click on the "wheel" icon to edit it (or right-click 
and select "Edit"). This should open a window: 

 
You can set: 
• Name: This is the name displayed in the list 
• Selector: This is the "action" that will be made. We recommend that you duplicate an 

existing action and then edit the parameter, as all possible actions are listed in the list, 
there are no other. 

• Parameter: Only certain actions support a parameter. This is true for example in 
OnTheAir Video to start playing a specific clip. 

• Enabled Image: It's the image that is used when the action is not active. 
• Active Image: It's the image that is used when the action is active. For example if a 

source is recording in MovieRecorder.  

10.1.4. Restore to Defaults  

The "Restore to defaults" button can be used if you want to 
restore to the default configuration. 
Note that this can be useful also if you want to use new 
features or buttons that were done in a new version of the 
application. It will also copy the new images to the folder. 
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10.1.5. StreamDeck Application 

We won't go into too much details, as you can find a lot of info on Elgato's website or on the 
web about this, but the idea is that you should first download and install the Elgato Stream 
Deck software. 
Again if you use the Softron integration, you should NOT start the Stream Deck software as 
it will prevent us to access the Stream Deck. It can be present on the computer, but not 
running. 
Once installed, you will be able to configure the buttons. 
For an integration with the Softron software, you will have to either: 
• send REST requests (you will have to know how our REST API works) 
• emulate keyboard shortcuts (you will have to know the keyboard shortcuts that you 

can use in our application) 

The advantage of the keyboard shortcuts, is that it's way easier to do, but the downside is 
that you will have to make sure that the application is the front application for the keyboard 
shortcut to work. If it's not the front application, the keyboard shortcut might do something 
different. The REST requests are a little harder to setup, but will work wether the application 
is front or not. All the steps are explained in our online article. 

 

https://gc-updates.elgato.com/mac/sd-update/final/download-website.php
https://softron.zendesk.com/hc/en-us/articles/115000048614-HOW-TO-Create-a-marker-in-M-Replay-using-the-REST-API
https://softron.zendesk.com/hc/en-us/articles/360015242494-HOW-TO-Use-Elgato-s-Stream-Deck
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11. Using REST API to Control M|Replay 

With M|Replay, you can create markers in the user interface but also using a REST API. This 
means that you can create markers remotely from simple web page.  
Currently the only thing you can do with the REST API is to add new markers. If you have any 
additional request, please let us know. 
M|Replay uses port 8082 by default, but this can be configured in the Settings of M|Replay. 

11.1. Creating Markers 
To add a marker, you need to use the POST method and pass a json dictionary with "name" 
to set the title of the marker. The marker will be added at the same position that the 
"playhead is". So if the user is playing back something in the past, it will use the current TC, 
not the "Live" TC. 
POST markers
     {
         "name" : "This is my Marker"
     }
 
About the authentication 
If the user has enabled the option to require a password, then you need to specify it with 
your requests. The default password is "1234". 
 POST markers?password={password}
     {
         "name" : "This is my Marker"
     }

11.2. Retrieving Markers 

You can also retrieve the list of markers that were already created: 
GET markers
This will return a dictionary with the list of sources available for a MovieRecorder, which 
should look like this: 
[
     {
         "name": "My First Marker",
         "start": 511090399.1733954
     },
     {
         "name": "My Second Marker",
         "start": 511090848.9727454
     },
         "name": "My Third Marker",
         "start": 511090850.8913287
     },
 ]
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12. Keyboard Shortcuts 
Note: On some keyboards "option" is indicated as “alt”, “Command” is indicated as “cmd” 
and “control” is indicated as “ctrl”. A number of keyboard shortcuts are available to control 
the UI, in addition to Mouse and other controls (see below for available Controllers). 

Viewers area - Playback Controls

Shortcut FUNCTION

J Cycle through the different playback speed going backwards

K Pause

L Cycle through the different playback speed going forward

Space bar Play/Pause

G Go to “Live”

control + G Go to “Specific Timecode” (enter TC)

+ Go to “+ x time” (enter TC)

- Go to “- x time” (enter TC)

Home Go to beginning of Session

End Go to end of session

→ + 1 frame

← - 1 frame

Viewers area - Selecting Viewers and assigning inputs

Shortcut FUNCTION

Shift + 1, 2, 3,.. Select the viewer you want to control

1, 2, 3,… Assign the input located in the corresponding viewer to the 
selected output

Clips and markers

Shortcut FUNCTION

I Set an in point

O Set an out point

Shift + I Go to in point

Shift + O Go to out point

option + I Clear the in point

Shortcut
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option + O Clear the out point

option + X Clear both in and out points

E  Append selected clip(s) to the end of the current playlist

W Insert selected clip(s) before the selected clip of the current playlist

command + E Export the selected Clips to the location defined in the settings

command + shift + E Export the selected Clips to a location that you will define

FUNCTIONShortcut

Playlists

Shortcut FUNCTION

space bar Play/Pause

option + space bar Force cue of selected clip

option + → Skip to next

option + ← Skip to previous

option + command + → Go to 5 seconds before the end of the current clip

option + command + ← Go to 5 seconds before the end of the previous clip

shift + O Go to out point of selected clip

option + L Toggle the playlist Loop mode

option + C Toggle the playlist Chain mode

command + E Export the selected Playlist to the location defined in the Settings

command + shift + E Export the selected Playlist to a location that you will define

UI Navigation

Shortcut FUNCTION

⇥ Cycle in the different areas going forward 

⇧ + ⇥ Cycle in the different areas going backwards 

S Go to the Sources Pane

V Go to the Viewers area

B Go to the Browser area

P Go to the Playlists area
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13. When Something Goes Wrong… 
While we strive to ensure that M|Replay be as stable a platform as is humanly possible, there 
is a lot of interaction between our software and other pieces of your workflow (your MacOS, 
video card drivers, switchers, etc.), and so we must constantly evolve our product to adapt to 
changes made in those applications. As such, bugs do sometimes sneak up on us. Should 
any issues arise while utilizing M|Replay the first place to look for answers to potential 
causes is our white pages on our Softron Support Desk website. 

Keeping an eye on the Performance Gauges in the Activity & Logs window (accessed via 
“Window > Show Activity & Logs Window”) is also a valuable resource. 
The Performance Gauges show the performance of your computer as it runs the application, 
and may prove a useful indicator as to what could be causing issues. See our 
Troubleshooting: The Log Window Explained article for details. 

And also keep in mind that for the life of the product, your application includes our support 
service. The best way to reach us is via “Help>Contact Support” in the user interface of the 
application (see below for image). Through that button you can collect the technical logs 
from the application and open a support ticket on our Support Desk. It is important that 
when opening a ticket that you supply as much information as possible, including the date 
and time of the incident(s).   

 

https://softron.zendesk.com/hc/en-us
https://softron.zendesk.com/hc/en-us/articles/207695067-TROUBLESHOOTING-The-Log-window-explained
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